WEBQUEST WORKSHOP
OVERVIEW (1 HR): What is a WebQuest?

A WebQuest is an inquiry-based, often interdisciplinary, unit of study in which
students get all or most of their information from the Web. Students use the
WebQuest to turn information into knowledge and demonstrate their knowledge
with a product. Teachers design WebQuests to address standards, differentiate
instruction, pre-select resources, and scaffold learning. Resources may include print
and other classroom and library materials; however, a true WebQuest must include
information that is only available on the Web.

WebQuests have the following parts (see “Building Blocks of a WebQuest,”
http:/ / projects.edtech.sandi.net/ staffdev /buildingblocks / p-index.htm):

1. Introduction—used to define expectations, set the stage, and motivate the students

2. Task-define the learner outcome or product and describe available tools (see, “WebQuest
Taskonomy: A Taxonomy of Tasks,” http:/ /webquest.sdsu.edu/taskonomy.html “. Bernie
Dodge suggests the following possible products:

problem or mystery to be solved;

position to be formulated and defended;

product to be designed;

complexity to be analyzed;

personal insight to be articulated;

summary to be created;

persuasive message or journalistic account to be crafted;

a creative work, or

anything that requires the learners to process and transform the information they've

gathered.

3. Process—describe in some detail the steps learners will take to arrive at their final products.
For example:
a. Work in cooperative learning teams
b. Choose a role to play
c¢. Gather information
d. Evaluate and organize your information
e. Demonstrate your knowledge by using your information to create your product

4. Evaluation—describe how student work and products will be evaluated. If a rubric will be
used, give it to the students and explain the levels of accomplishment for different
performance objectives

5. Conclusion-summarize the goals of the unit of study.

= I

Activity:
1. Introduction—Examine a WebQuest to learn about the features, design, and functions
2. Task—Report back to the whole group with a summary of the WebQuest that you examine
noting strengths and weaknesses and possible application in your own teaching situation
3. Process—
a. Work in cooperative learning teams of teachers grouped by grade level.
b. Select one of the following WebQuests:
= Grade 2, Native American WebQuest,
http://mysite.verizon.net/vze1p9fr/mrsb124/teacher/webquests/rev%20na/index.htm
= Grade 2, An Insect's Perspective, http://projects.edtech.sandi.net/grant/insects/t-
index.htm
= Grade 2, Science-Water Habitats, http://ebhj.htmiplanet.com/#goal%20one
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= Grade 3, Planet WebQuest,
http://schools.sbe.saskatoon.sk.ca/Victo/projects/Grassroots/Planet%20WebQuest/
WebQuest2.html

= Grade 3-5, A Tale to be Told,
http://schoolweb.missouri.edu/nixa.k12.mo.us/sullivan/tales/index.htm

= Grade 5-8, Roller Coaster Madness,
http://www.esc2.net/TIELevel2/projects/roller/default.ntm#Introduction

= Grades 5-12, Guess Who's Coming to Dinner,
http://www.mcvts.org/ettc/mentoring/GuessWho.htm#Introduction

» Grade 6-12, THE TITANIC: What Can Numbers Tell Us About Her Fatal Voyage?
http://asterix.ednet.lsu.edu/~edtech/webquest/titanic.html

c. Think about the critical elements. Is this a good WebQuest? Could you use this

WebQuest with your students, or would this serve as a good model as you develop your

own WebQuest? Does it address curriculum standards, differentiated instruction, quality

resources that would not be available except on the Web, and higher order thinking

skills?

Note that many examples are not current, have bad or broken links, or have design
issues that you would wish to change in your own adaptation. The examples, might,
nevertheless, have great ideas that you would want to borrow as a starting point for your
own WebQuest. When designing your own WebQuest, be very selective in identifying
resources. Always include the publishing date and last updated date on your Web
pages. Understand and abide by the copyright for any source that you use. Read one
example of a copyright statement at
http://oncampus.richmond.edu/academics/education/projects/webquests/photosynthesis/
4. Evaluation— Prepare and present a recommendation for your peers about use (or not) of
this WebQuest based on your observations about critical elements and curriculum issues.
Explain what you would do differently in your own WebQuest.
5. Conclusion-Think about the WebQuest format. How might WebQuests improve learning in
your classroom? How would the teaching and learning roles change when using
WebQuests?

CURRICULUM INTEGRATION (2 HR)
How Are WebQuests Integrated into Curriculum?

WebQuests provide a vehicle for teachers to design inquiry units of study that
incorporate several content areas, focus on local standards, and differentiate
instruction. Teachers select Web (and other resources) to provide quality assurance
and focus student time on using and evaluating information instead of searching for
it.

Activity:
Introduction—Compare four or five WebQuests
Task—Report back to the whole group with a summary of the WebQuests that you examine
noting strengths and weaknesses and possible application in your own or a colleague’s
teaching situation
Process—
a. Work in cooperative learning teams of four teachers grouped by grade level.
b. Go to the WebQuest Training Materials page at http://webquest.sdsu.edu/materials.htm
c. Under “A WebQuest about WebQuests,” choose your grade level.
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d. Use A WebQuest About WebQuests (90 MIN) (with printable worksheet)
http:/ /webquest.sdsu.edu/webquestwebquest-es.html, including the process and roles.
e. Summarize your findings in a report for the whole group. Think about the critical
elements. Is this a good WebQuest? Could you use this WebQuest with your students,
or would this serve as a good model as you develop your own WebQuest? Does it
address curriculum standards, differentiated instruction, quality resources that would not
be available except on the Web, and higher order thinking skills?

Note that many examples are not current, have bad or broken links, or have design
issues that you would wish to change in your own adaptation. The examples, might,
nevertheless, have great ideas that you would want to borrow as a starting point for your
own WebQuest. When designing your own WebQuest, be very selective in identifying
resources. Always include the publishing date and last updated date on your Web
pages. Understand and abide by the copyright for any source that you use. Read one
example of a copyright statement at
http://oncampus.richmond.edu/academics/education/projects/webquests/photosynthesis/
Evaluation—Think about the critical parts. Are these good WebQuests? Could you use them
with your students, or would one or more serve as a good model(s) as you develop your
own WebQuest? Prepare and present a recommendation for your peers about use (or not)
of this WebQuest based on your observations about critical elements and curriculum issues.
Explain what you would do differently in your own WebQuest.
Conclusion—-Compare and contrast the WebQuest that you viewed in this activity with the
WebQuest that you plan to create.

Activity:

1.

Introduction— Contribute to the body of knowledge about WebQuests. Since 1995, a many

teachers have become part of the WebQuest community. Teachers create their own

WebQuests and share them by submitting them to the WebQuest site. You can now search

for, rate, and comment on WebQuests developed by other teachers.

Task—Now that you are familiar with a variety of WebQuests, have your own expectations

for critical elements, and have refined your evaluation skills, you will contribute to the

WebQuest community by evaluating a new WebQuest.

Process

a. Go to the WebQuest Portal at http:/ /webquest.org/

b. In the side bar on the left, select “New.” You will see a matrix of newly submitted
WebQuests that have not yet been evaluated.

c. Select a WebQuest (more than one, if time permits) and evaluate it.

Evaluation—Use the rating scale provided with each WebQuest on the Portal to rate the

WebQuest you selected. Select “Rate It” beside the WebQuest that you want to look at. You

will have two windows on your desktop. You will view the WebQuest in one window and rate

it in the other window.

Conclusion-When you complete your evaluation, click the “Submit Rating” button

at the bottom of the Rating Form. Your rating will be submitted to the database and

contribute your evaluation to the WebQuest community.
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CREATION (3 HR)

How Will My WebQuest Improve Teaching And Learning In My Classroom?

How Can I Make a WebQuest With or Without Making a Web Page?

Introduction-The focus of this workshop is creation of your own WebQuest.

Task-Your product will be a WebQuest (or at least a draft) that includes introduction, task,
process, evaluation, and conclusion. You will select Web resources that your students will
use. You will scaffold learning by designing a process that leads students to higher order

thinking.

Process—

1. Decide whether you want to create your WebQuest as a word processing document, using
Word, or as a Web page, using DreamWeaver (or any web editor).

Activity—Look at the two versions of this workshop material:

¢ This workshop was created in Microsoft Word as a word processing document and
saved as .rtf (rich text format) and as .pdf (portable document format). Go to
http://www.etcgroup.inf/webquest. You will see a document to download in .rtf or .pdf

format. When you download that document to your computer, you will have these pages
but the links will be “hot,” working links.

To make the .rtf version, use

File > Save As and choose Format > Rich Text Format.

Rich Text Format documents can be opened by a variety of word processors and
can be edited by the user just like any other word processing document. On the
desktop, links will be “hot,” and clicking will open a web browser (Netscape or
Internet Explorer) and take the user directly to the web address (url).

To make the .pdf version, use

File > Print > Save as PDF.

Adobe Acrobat Reader opens PDF documents. PDF documents retain the original
formatting but cannot usually be edited by the user. On the desktop, links will be
“hot,” and clicking will open a web browser and take the user directly to the web
address (url).

¢ This workshop was also created as a Web page, http://www.etcgroup.inf/webquest.

Word was used for the draft. Then a DreamWeaver page was created. The text from

the Word document was copied and pasted into the Dream\Weaver page.

A WebQuest could be created directly in any web editor (such as DreamWeaver).

Not recommended: Word has the option to Save as a Web Page. This method works

but creates messy html code. Sooner or later you might have to clean up that code.

As an experiment, this document was converted to web pages using two different

methods:

= Created in Word and Saved as a Web Page, resulted in 838 lines of code.
See this example.

= Created in Word, Copied and Pasted into a DreamWeaver document made
from a template, resulted in 422 lines of code including the menus and
graphics in the template. See this example.
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2. Create your WebQuest using whichever software you wish. Focus on the content of the
WebQuest during this workshop. You might choose to create your draft today in Word and
use that content later when you construct your Web page.

3. Itis important to complete the WebQuest development process today, even if you do
substantial editing and revising later. Design and write the following parts of your

WebQuest:

e Introduction
e Task

* Process

* Evaluation
e Conclusion
4. Use these resources as needed to help you with your development:
* To adapt an existing WebQuest for your own use see: Adapting and Enhancing
Existing WebQuests http://webquest.sdsu.edu/adapting/index.html
* To use a template see: WebQuest Template, Student Page
http://projects.edtech.sandi.net/staffdev/tpss99/mywebquest/index.htm

Evaluation-Evaluate your WebQuest using the Rubric for Evaluating WebQuests
http://webquest.sdsu.edu/webquestrubric.html

Conclusion—At this point, you have learned the format and advantages of using a WebQuest
for inquiry units of study that incorporate several content areas, focus on local standards,
differentiate instruction, and scaffold learning to higher order thinking skills. You have
written the introduction, task, process, evaluation, and conclusion for your own WebQuest.
You have selected the Web resources that your students will use so they will focus on using
the resources rather than finding them. You have structured the task and process to lead
students to higher order thinking, processing information to create knowledge and
demonstrating understanding by producing a product.

No doubt, as this day ends, you feel that you are just beginning. You will want to continue
working on your WebQuest. Searching for resources and refining the list of Web sites that
you want your students to use is addictive and time consuming. Your WebQuest creation
process, like any writing project, is recursive. That is, the more you reflect and edit, the better
your product becomes. When you are satisfied with your WebQuest, submit it to the
WebQuest Portal at http://webquest.org/wqdb/editwg.php.

Warning: You probably cannot do just one! As you develop your first WebQuest and think
about the possibilities for the other units that you teach, you may feel the need to create more
WebQuests. The good news is that the resources used in this workshop continue to be
available to you.

CREDITS: The WebQuest project was developed by Bernie Dodge with Tom March, San Diego State
University, and has been widely replicated since 1995. Dr. Dodge generously grants permission for use of
his work in non-profit, educations settings. Most of the materials used or referenced in this workshop are
the work of Bernie Dodge.
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